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Coca-Cola is proud to be part of China’s Olympic journey—a journey that’s making  

history as it flings open the doors of East to West in a celebration of all that connects  

us and all that makes us unique. We developed the Coke China Visual Identity System  

to express the shared ideals of Coca-Cola, China, and the Olympic Games. Every  

element in the system—logo, colors, photographic styles, typography, backgrounds—was 

designed to tell a story about a nation on the rise, filled with possibilities, and brimming 

with anticipation about its upcoming moment on the world’s stage. Exuberant. Beautiful. 

Bold. Young. Passionate. Dynamic. China on the Coke Side of Life.

 



The Olympic Games are the world’s greatest visual event;  
a chance for an Olympic city to share its culture and  
aesthetic with the world. The Olympic Look of the Games 
is a visual imaging system that creates a colorful, cohesive 
environment in the host city and country for the spectator 
and global television audience. In the competition venues, 
the Look creates a dynamic backdrop for the competition, 
inspiring Olympic athletes to world-class performance.  
The Coca-Cola Global Look of the Games: Beijing 2008 
Olympic Games is a Visual Identity System designed to  
create the same excitement and emotional engagement 
with our consumers and the world.

�   C O CA - C O L A  G LO B A L  LO O K  O F  T H E  GA M E S :  B e i j i n g  2 0 0 8  O ly m p i c  G a m e s  v 1 . 0

 Visual Identity System



Our approach is grounded  
in 3 principles:
As Familiar as a Home Team
We leverage all that is real, authentic, original, and  
iconic about the brand. Clearly linking to our heritage  
gives us the license to try new things and keep evolving.

As Inspirational as an Olympic Moment
We do not follow category norms; we lead them.  
Sometimes we challenge with a point of view, other  
times we just bring a smile. We emphasize craft and  
a human voice.

As Dynamic as an Athlete
We’re developing a dynamic and modular Look of the 
Games system—built for mass customization. We use 
our ubiquity to create variety and freshness across  
the brand experience.
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 Principles  



�   C O CA - C O L A  G LO B A L  LO O K  O F  T H E  GA M E S :  B e i j i n g  2 0 0 8  O ly m p i c  G a m e s  v 1 . 0

The framework is how we categorize our marketing communications to 
build a holistic, yet flexible brand identity. Drawing from a consistent set 
of Elements, we have developed a range of Executions that can be used 

“as is”or customized locally based on the key message, consumer target 
and physical environment. This provides our System with “freedom within 
a framework.”

 Strategic Framework

Iconic
TIMELESS  equities:

Logotype, Contour, Red

Intrinsic
intrinsic focus:

Icy Cold, Taste, Refreshment

Extrinsic
Extrinsic FOCUS:

CSOL (idea) Amplification

Shared
program FOCUS:

Global Look of the Games: Beijing 2008 
Olympic Games

Global Look of the  
Games Elements

A B C D E F G H I J K L M N
O P Q R S T U V W X Y Z
a b c d e f g h i j k l m n
o p q r s t u v w x y z
0 1 2 3 4 5 6 7 8 9
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The Coca-Cola Global Look of the Games: 
Beijing 2008 Olympic Games connects East  
to West in a seamless continuum—and vice 
versa. It is a dynamic communications system 
that includes elements for applications as 
specific as Coke China and as broad as global 
Coke. From simple and iconic elements to 
more complex, Coke Side of Life-type 
elements, the system is designed to be both 
flexible and holistic. We call it Freedom Within 
a Framework, and it means that you can 
customize design based on what best works 
for your application’s key message, target 
audience, and physical environment. The chart 
provided at left offers the best explanation of 
how this continuum works. 

 System Dial 
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Elements are the “building blocks”  
of the Look of the Games.
Consistently using a common set of elements  
enables integrated marketing communications (IMC)  
and maximum system scale.

Our Elements include:
Composite Logo
Refreshment Bubbles
Prism
Contour Bottle
Typography
Foregrounds
Backgrounds
Color
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COMPOSITE LOGO Refreshment BUBBLES PRISM

CONTOUR BOTTLECONTOUR BOTTLE TYPOGRAPHY

BACKGROUNDs COLOR

The Coca-Cola Global Look of the Games is  
composed of dynamic design elements that 
express the essence of the Olympic Games in 
China and fulfill the promise of the Coke Side 
of Life. These design elements can be used 
together to create a myriad of compositions.

See specific rules for usage of each element. 

Most design elements come already combined 
into art and should not be manipulated 
separately.

The “Worldwide Partner” designation must 
always be clearly legible on all applications  
in which it appears.

foreGROUNDs

  Overview
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The Composite Logo is the primary expression 
of the Coca-Cola Beijing Olympic Look of the 
Games, and its most important design 
element. In it is captured the promise and 
possibility of the upcoming Beijing 2008 
Olympic Games. Inspired by the fluid form of a 
soaring kite, its form is uniquely Chinese and 
brings alive the story of China on the Coke 
Side of Life.  The second level is a prism, or 
window, into New China, offering a two-way 
exchange of Chinese culture and the enduring 
values at the heart of the Olympic Movement. 
The world can see in, and China can see out. 
The soaring forms of the composite logo are 
an apt visual metaphor designed to express 
the attributes at the heart of Coke’s brand: 
optimistic, dynamic, transparent, and global.

 Primary Composite Logo



11   C O CA - C O L A  G LO B A L  LO O K  O F  T H E  GA M E S :  B e i j i n g  2 0 0 8  O ly m p i c  G a m e s  v 1 . 0

The Primary Composite is composed of two 
levels. The top level brings together the  
Coca-Cola logotype and various Olympic 
identifiers (the Beijing 2008 logotype, Olympic 
Rings and the official sponsor designation). 

The bottom level of the composite is the 
“prism” device. There are two main variations 
of the prism device: in China, the bottom  
level art references the Beijing Olympic Games 
Organizing Committee “Lucky Clouds,” while 
globally the bottom level references a modern 
architectural design element. 

The Primary Composite should be 4-color 
CMYK in the vast majority of executions. 

Used alone, this top level forms the  
Single-level Composite, provided for when  
a simple version of the logo is needed for 
production reasons. 

china version / english logotype china version / chinese logotype

  Composite Logo Variations

primary global version
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The Primary Composite should be used at  
a size no smaller than 2.5 cm, measured 
from left to right using the main red body of 
the composite—not the grey outline.

The clear space directive is shown bottom left. 
Do not place objects within the clear space  
denoted around the Primary Composite. 

NOTE: This clear space directive does not 
include design elements such as the Contour 
Bottle, Prism, or Refreshment Bubbles. These 
three design elements may be overlaid by the  
Primary Composite.

= 2.5 cm

Actual size

x

x

x

x

x

>

MINIMUM SIZE

CLEAR SPACE

 Minimum Size and Clear Space
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DO NOT rearrange components within  
the Primary Composite.  

DO NOT lift the logotype from  
the containing shape. 

DO NOT change the color of  
the Primary Composite. 

DO NOT skew or distort the 
Primary Composite.  

DO NOT rotate or place the Primary  
Composite at an angle.

DO NOT change the relationship of the  
two levels of the Primary Composite. 

DO NOT change the prism within  
the Primary Composite. 

DO NOT add any effects to  
the Primary Composite. 

 Don’ts
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PRIMARY COMPOSITE

PRIMARY COMPOSITE
COKE LIGHT

PRIMARY COMPOSITE
“LUCKY CLOUDS”

PRIMARY COMPOSITE
“LUCKY CLOUDS” /  CHINESE

PRIMARY COMPOSITE—GAMES TIME
“LUCKY CLOUDS” /  PICTOGRAMS

PRIMARY COMPOSITE
OLYMPIC RINGS

PRIMARY COMPOSITE
DIET COKE

PRIMARY COMPOSITE
COKE ZERO

There are five versions of the Primary 
Composite. The most-used version includes 
the Beijing 2008 logo. Another version 
references the Olympic Rings. The three 
“Lucky Clouds” versions of the Primary 
Composite are for use ONLY in China.

In addition, three product (Diet Coke, Coke 
Light, and Coke Zero) versions are provided. 

 Composite Logo Family
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The Olympic Rings version of the Primary 
Composite can be used to strengthen Coke’s 
connection with the global Olympic Games 
brand. 

This configuration is the official designation. 
It must always be presented in this arrange-
ment, except for very small executions such 
as pins.

 Olympic Rings Composite
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The Single-level Composite consists only of 
the top level of the composite logo. It should 
be used when production of the entire Primary 
Composite would be impossible or cost-
prohibitive, or when a smaller size is required. 

This 4-color CMYK version of the Single-level 
Composite should be used whenever possible, 
and is preferable to limited color versions.

4-COLOR (CMYK) version

 Single-level Composite
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2-COLOR WITH OVERPRINT 2-COLOR FLAT

The Single-level Composite is provided as  
2-color art for occasions where 4-color  
(CMYK) printing is not possible. 

Two versions of 2-color art for the Single-level 
Composite are provided. The preferred version 
consists of Coke Red with a black overprint, 
which appears much more three-dimensional 
than traditional 2-color art files. The other 
version consists of Coke Red, flat, with a  
Dark Coke Red shadow. 

The Single-level Composite is provided  
as 1-color art for occasions where 2-color 
printing is not possible. This version is  
flat 100% Coke Red.

No other design element has been created 
or modified for a 1-color execution, and none 
should be created or modified.

The Single-level Composite is provided in 
100% black for very rudimentary executions. 
One-color black executions should be avoided 
if possible.

1-COLOR red 1-COLOR black

 Single-level Composite in Limited Colors
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A Diet Coke version of the Primary Composite 
is provided for when a product-specific 
execution is desired. 

 Diet Coke Composite
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A Coca-Cola Light version of the Primary 
Composite is provided for when a product-
specific execution is desired. 

 Coke Light Composite
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A Coca-Cola Zero version of the Primary 
Composite is provided for when a product-
specific execution is desired. 

 Coca-Cola Zero Composite
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DIN Pro is the typeface used in the Coca-Cola 
Beijing Olympic Look of the Games. The most 
common use of typography in the Look of the 
Games will be in headlines, such as call-to-
action, special offers, promotions, etc.

Ideally, headlines should be adapted in one  
of two ways: the preferred treatment and the 
secondary treatment. Details for the preferred 
treatment can be found on page 22, and for the 
secondary on page 23.

All weights of DIN are approved for secondary 
uses, such as body copy and descriptors.

Cooper Black is approved for use in pricing, 
though DIN may be used instead if preferred.

For other languages that are not applicable  
to DIN, please work with a similar font that  
is best for your market. 

SUBHEADS AND TEXT

PREFERRED HEADLINE TREATMENT SECONDARY HEADLINE TREATMENT

PRICING

DIN Light

DIN Light Italic

DIN Regular 

DIN Regular Italic

DIN Medium 

DIN Medium Italic

DIN Bold 

DIN Bold Italic 

DIN Black Italic 

Cooper Black

 Typography

See Legal Guidelines on page 88 for font licensing information.
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Shown at left is the preferred treatment  
for all headlines in the Coca-Cola Global  
Look of the Games. Instructions for creating 
this headline treatment can be found on the  
next page. 

HEADLINE OR CALL-TO-ACTION

 Typography—Preferred Headline Treatment

See Legal Guidelines on page 88 for font licensing information.
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When the preferred headline treatment is not 
possible, this secondary treatment is allowed: 
DIN Medium with each line manually justified, 
with type size increased and decreased per 
line to fit. The headlines should be in Coke 
Red when on light backgrounds and in White 
when on primarily red backgrounds.

When it is not possible to manually justify each 
line, a straightforward center or left align is 
also permitted; however, the more proprietary 
justified headline treatment should be used if  
possible to create a cohesive look-and-feel.

THIS A THEMATIC
HEADLINE

SECONDARY
CALL-TO-ACTION

TREATMENT

SECONDARY
CALL-TO-ACTION

TREATMENT

THIS A THEMATIC
HEADLINE

THIS A THEMATIC
HEADLINE

SECONDARY
CALL-TO-ACTION
TREATMENT

SECONDARY
CALL-TO-ACTION
TREATMENT

THIS A THEMATIC
HEADLINE

DIN MEDIUM / MANUALLY JUSTIFIED

DIN MEDIUM / CENTER ALIGN DIN MEDIUM / LEFT ALIGN

 Typography—Secondary Headline Treatment

See Legal Guidelines on page 88 for font licensing information.
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Set type in DIN Regular (Bold also acceptable), 
all caps, set tracking to -10. Adjust spacing 
between letterforms (kern) as needed. Use type 
point size from 16 points to 36 points: larger or 
smaller can be scaled after completion of steps.

Separate the headline into individual lines, 
breaking lines according to word emphasis. 
Scale each line to the same width. Make the 
spacing between each line equal.

Outline (Type > Create Outlines) each line 
individually. Make a note of type point size for 
each line before converting to outlines.

Working one line at a time, copy and paste  
(Edit > Copy, Edit > Paste in Front) an 
identical line on top. 

Add a stroke to the top line. Use the type size 
noted before converting to outlines (see table, 

1

2

3

bottom right) to determine point size of stroke. 
Next, outline the stroke (Object > Path > 
Outline stroke).

Under Window, open the Pathfinder palette. 
Under the arrow upper right, go to Make 
Compound Shape. Press Expand. The line of 
copy should now be solid.

Make the line a compound path (Object > 
Compound path > Make) so that the gradient 
spans the width of the line.

Add the gradient*. Send that line to the back 
(Object > Arrange > Send to back).

Working with the front line (the original one not 
outlined), create a compound path (Object > 
Compound path > Make). Add the gradient*. 

Repeat all steps for each line.

The back layer of type (the one with the outline) 
should correspond with the background color.

The color of the gradient should be as follows:

RED: Linear gradient, 30º angle, dark red (C0 
M100 Y100 K50) to Coke Red to dark red, 
Location 50%.

WHITE: Linear gradient, 30º angle, blue (C22 
M0 Y0 K20) to white to blue, Location 50%.

*

Stroke / Outline Point Size

Type Point Size Stroke Point Size
16-20 point type 1 point stroke
21-25 point type  1.5 point stroke
26-30 point type  2 point stroke
31-35 point type  2.5 point stroke
36 point type 3 point stroke 

4

5

6

1 2 3

4 5 6

 Typography—Headline Construction

See Legal Guidelines on page 88 for font licensing information.
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The Coca-Cola Global Look of the Games is a 
system meant to be printed in 4-color CMYK, 
not in flat Pantone® colors. The exceptions to 
this are the 2-color and 1-color Single-level 
Composite options on Page 17 .

Prism colors, a brilliant range of colors,  
are incorporated into the Prism art. These 
colors should never be added to a layout and 
should exist only in the design elements and 
Foreground and Background art provided.

Coke Red is the primary color used in the 
Coca-Cola Beijing Olympic Look of the Games. 
Black is the secondary color.

Coke Dark Red is used in the 2-color version  
of the Single-level Composite logo and is 
used as an occasional accent ONLY in 2-color 
executions where CMYK is not available.

PRISM
COLORS

COKE
RED

Pantone®:
Coke Red

HEX: #E41E2A

RGB: R228 G30 B42

CMYK:
C4 M100 Y95 K0

COKE
DARK
RED

Pantone®:
PMS1805

HEX: #B51F2C

RGB: R181 G31 B44

CMYK:
C19 M100 Y91 K12

COKE
BLACK

HEX: #0A0204

RGB: R10 G2 B4

CMYK:
C30 M30 Y30 K100

R116 G0 B0

HEX #74000 

C31 M100 Y100 K44

R228 G30 B42

HEX #E2202B

C4 M100 Y95 K0

R237 G19 B93

HEX #EC195E

C0 M99 Y47 K0

R244 G121 B32

HEX #F47920

C0 M65 Y100 K0

R255 G194 B14

HEX #FFC20E

C0 M25 Y97 K0

R228 G30 B42

HEX #E2202B

C4 M100 Y95 K0 

R247 G147 B29

HEX #F7931D

C0 M50 Y99 K0

R247 G147 B29

HEX #F7931D

C0 M50 Y99 K0

R202 G219 B42

HEX #CADB2A

C25 M0 Y99 K0

R140 G198 B63

HEX #8CC63F

C51 M0 Y100 K0

R0 G110 B58

HEX #006E3A

C90 M32 Y98 K22

R88 G21 B109

HEX #58156D

C78 M100 Y23 K14

R158 G38 B143

HEX #9E268F

C43 M99 Y0 K0

R0 G135 B205

HEX #0087CD

C80 M37 Y0 K0

R0 G173 B239

HEX #00ADEF

C69 M15 Y0 K0

R228 G30 B42

HEX #E2202B

C4 M100 Y95 K0 

R10 G2 B4

HEX #0A0204

C30 M30 Y30 K100

R111 G111 B113

HEX #6F6F71

C57 M49 Y47 K15

R10 G2 B4

HEX #0A0204

C30 M30 Y30 K100

 Color
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Most executions should include Contour  
Bottle art, whether the vector art version  
or a photographic version. Any higher-level 
non-product-driven execution should be 
accompanied by the Contour Bottle and the 
“Coke Side of Life” (CSOL) tagline, provided 
together as an art lockup. 

The Photographic Contour Bottle may be  
used instead of the “Coke Side of Life” Lockup 
(especially if a more product-driven look-and-
feel is desired), but not if the Photographic 
Contour Bottle competes with any promotional 
items shown.

Specific rules for use of the Contour Bottle  
can be found on Page 29.

 

contour bottle / iconic

contour bottle / intrinsic

 Contour Bottle
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 Photography

Figures of athletes are clipped out of the photographic environment  
and used as silhouettes. This athlete-focused Olympic Games  
Photography is placed between Foreground and Background art, or  
over a solid background. 

The Photographic Contour Bottle may also be used as an iconic image. 
Use one of the approved Composite Logo / Photographic Bottle 
lockups, and place it over the foreground art so that the “V” shape 
appears to come from behind the bottle. Size the Composite Logo /
Photographic Bottle lockup to be between 1/2 and 2/3 the height  
of the total composition.
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side of life. TMlive Olympic on the 
side of life. TMlive Olympic on the 

The Contour Bottle should not float within an execution. Instead, it should be anchored by 
overlaying the Primary Composite across the bottom of the bottle. The Primary Composite 
should be used this way in most executions—except those which utilize a Corner Element. 
Corner Element art may be used as a substitute for the Primary Composite. 

side of life. TMlive Olympic on the 
side of life. TMlive Olympic on the 

The Contour Bottle can be used alone in intrinsic, product-centric or POS executions:

Use the “Coke Side of Life” lockup in extrinsic executions:

Markets are free  
to use either 
“Coca-Cola” or 
“Coke” according  
to which best fits 
your market.

or
The “Coke Side of Life” tagline is provided in lockup with the Contour Bottle. Do not change 
the relationship between the tagline and the Contour Bottle. 

 Contour Bottle

side of life. TMlive Olympic on the side of life. TMlive Olympic on the 
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The Coke Side of Life is expressed in the Look 
of the Games through the fusion of the 
Contour Bottle and the Composite Logo. 

Provided in the appendix are approved 
lockups. These include approved size relation-
ships (bottle to composite logo) in the “Coke,” 
“Coca-Cola,” and Olympic Rings/Worldwide 
partner, and photographic versions of the 
bottle. The graphic bottles are provided in  
red and knock out.

 Contour Bottle / Composite Logo Lockup
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The Prism is the most proprietary element 
specific to the Coca-Cola Beijing Olympic  
Look of the Games. It is a vividly transparent 
window that invites a two-way exchange: the 
world can see in, and China can see out. The 
world participates in China’s Olympic moment, 
and China engages with the world.

The Prism art is already integrated into the 
provided foreground art, and should not be 
added to any execution already containing 
foreground art. 

red / dragon white / no dragon

red / no dragon white / dragon

 Prisms
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Refreshment Bubbles are a colorful, fun 
and highly dynamic element, representing  
the optimistic Olympic spirit that’s bubbling 
up, out, and all around China. The Bubbles 
are a primary component of the Look of the 
Games, and they visually unite the Coca-Cola 
brand with the Olympic Rings.

The Refreshment Bubbles are integrated into 
the provided Foreground and Background art, 
and should not be used individually except in 
special executions. 

red / no dragon

white / dragon

red / dragon white / no 

dragon

 Refreshment Bubbles
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orForeground 1 / Red Foreground 2 / Red orForeground 1 / WHITE Foreground 2 / WHITE

 Foregrounds

top element

Corner element / Red Corner element / WHITE
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 Backgrounds

COMPLEX Background / Red COMPLEX Background / WHITE

Simple Background / WHITE solid white background  Simple Background / Red



There are many formats which need to be considered  
in applications to ensure the overall communication  
piece provides an outcome that has creativity,  
consistency, and clarity.

Within this section, we outline various layout applications 
to suit different shapes and formats, all of which  
consistently communicate the Look of the Games.
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primary layout

(Foreground art)

alternative layout

(Top element)

Executions using the Coca-Cola Global  
Look of the Games are constructed in one  
of three layout types. All capture the upward 
motion and optimism of the Coke Side of  
Life campaign. 

Shown here are schematics of horizontal and 
vertical Primary layouts, and an alternative 
layout for special situations.

Details of each layout type can be found  
on the following pages.

 Layout Templates
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Primary Layouts are composed of Foreground 
art and Background art combined in layers, to 
which other design elements are added.

Background and Foreground art can be 
cropped for a more horizontal layout, and the 
bottom of the Foreground art can be extended 
for a more vertical layout.

Foreground and Background art already utilize 
the Prism and Refreshment Bubble design 
elements in combination: these elements  
should not be added to the execution or 
manipulated separately.

use only red  
FOREGROUND 1 / 

RED foreground 2

use only with simple 
background red /
COMPLEX BACKGROUND 
RED

use only white  
FOREGROUND 1 /

white FOREGROUND 2

use only with  
simple background 
white / COMPLEX 
BACKGROUND
white   

 Primary Vertical Layouts

white layoutred layout
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Foreground and Background art is manipulated separately to fit the 
format of the execution being created and combined. Other design 
elements, including Olympic Photography, Contour Bottles and the 
Primary Composite, can be added to this layered Foreground and 
Background art. 

Olympic athlete photography should, when used, be placed in between 
the Foreground art and Background art, and used as a high-quality  
clipping path (or alpha channel).

 Creating Primary Vertical Layouts

FOREGROUND art
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side of life. TMlive Olympic on the 

BACKGROUND art CONTOUR BOTTLE / 

“COKE SIDE OF 

LIFE” lockup

represents 

OLYMPIC 

PHOTOGRAPHY

TYPOGRAPHY EXECUTION

=

+ + +

primary

composite

+

FOREGROUND art

+

BACKGROUND art CONTOUR BOTTLE / 

PHOTOGRAPHIC

TYPOGRAPHY

+ +

primary

composite

+

EXECUTIONolympic rings / 

partner lockup

+

FPO
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Primary Horizontal Layouts allow for  
maximum product exposure. 

Primary Horizontal Layouts utilize the two 
versions of the Simple Background art (plus 
the option of a solid white background to be 
used only when imprinting is required) to 
which the Top Element is added.

A Corner Element may be added to some 
wider horizontal layouts that already include 
the Top Element, as long as the layout is at 
least three times wider than the width of the 
Top Element used. 

 Primary Horizontal Layouts

simple 
background / 

white

top
element

corner  
element / white
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Primary Horizontal Layouts are manipulated separately to fit the  
format of the execution being created and combined. Other design 
elements, including Olympic Photography, Contour Bottles and the 
Primary Composite, can be added to this layered Foreground and 
Background art. 

Olympic photography, when used, should be placed in between  
the Foreground art and Background art.

=+

CONTOUR BOTTLE / 

PHOTOGRAPHIC

TYPOGRAPHY

+ +

corner element / 

white

+

EXECUTIONTOP ELEMENT PRODUCT 

PHOTOGRAPHY

 Creating Primary Horizontal Layouts
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TOP
ELEMENT

SIMPLE
BACKGROUND /
RED

TOP
ELEMENT

SOLID WHITE
BACKGROUND OR
SIMPLE BACKGROUND /
WHITE

 Alternate Vertical Layout

Alternate Vertical Layouts are composed of 
Top Element art and Simple Background art 
combined in layers, to which other design 
elements are added.

Background can be cropped for a more  
horizontal layout.

Top Element art already utilizes the Prism  
and Refreshment Bubble design elements  
in combination: these elements should not  
be added to the execution or manipulated 
separately.
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 Creating Alternative Vertical Layouts

BACKGROUND art

+ =

TOP ELEMENT PRODUCT 

PHOTOGRAPHY

TYPOGRAPHY EXECUTION

+ +

primary

composite

+

Alternative Layouts are most effective for Point-of-Sale executions and  
horizontal layouts since the Top Element can be used on the more 
simple and scalable backgrounds, plus white. These layouts allow for 
plenty of room for Product Photography and pricing.

Other design elements, including Olympic Photography, Contour Bottles 
and Composite Logos, can be added to these layered layouts.




